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RESUMO

Entre as principais obras de Arte da Engenharia Civil temos as pontes e os viadutos que são
essenciais para o transporte de cargas em estradas e ferrovias, sendo responsáveis por fazerem a
ligação nos pontos críticos destas, garantindo uma trajetória de continuidade. Há uma tendência
natural ao desgaste das estruturas que leva ao aparecimento de manifestações patológicas, com
isso torna-se necessário a utilização de ferramentas para prever esses possíveis problemas.
Assim esta monografia tem como objetivo estudar os efeitos de uma corrosão localizada em uma
longarina de concreto protendido através de simulações numéricas utilizando o programa ANSYS
Workbench que recorre internamente ao método dos elementos finitos. Duas abordagens de
armadura para simulação, empregados na literatura, foram usados o discreto e o embutido. Foram
realizadas 84 simulações, divididas em quatro grupos cada um com vinte e uma, assim como
os cálculos do resultado esperado. Os grupos que utilizaram a abordagem discreta tiveram um
resultado melhor quando a qualidade da malha era baixa, enquanto que com a outra abordagem,
se tem resultados mais atraentes com uma malha mais refinada. Ao observar os resultados
das simulações com o calculado chegou-se ao entendimento que estavam demostrando um
comportamento não elástico do concreto, como era esperado, os deslocamentos vistos foram
maiores do que aqueles calculados. Ao ver que a tensão nos cabos de aço não chegou ao limite de
escoamento utilizado e que as tensões principais estavam, em alguns casos, acima do concreto,
tal razões levam a acreditar que pode ter ocorrido o esmagamento do concreto e que o elemento
utilizado não conseguiu demonstrar tal comportamento. Por fim chegou-se a conclusão que a
ferramenta utilizada pode ser usada para o objetivo proposto e são sugeridos novos trabalhos.

Palavras-chave: Simulação estrutural. Método dos elementos finitos. Ponte. Ansys.



ABSTRACT

The bridges are among the main Civil Engineering works of art, they are essential for the
transport of freight on roads and railways, being responsible for connecting them at critical
points, ensuring a trajectory of continuity. In nature there is a tendency to wear down every
structure leading to the appearance of pathological manifestations or problems, which makes it
necessary to use tools to predict these possible problems. Thus, this monograph aims to study the
effects of a localized corrosion in a prestressed concrete stringer through numerical simulations
using the ANSYS Workbench program that internally uses the finite element method. Two
reinforcement approaches for simulation employed in the literature were used, the discrete and
the embedded. 84 simulations were performed, divided into four groups each with twenty-one, as
well as the calculations of the expected result. The groups that used a discrete approach have had
a better result when the mesh quality is low, while the other approach have had more attractive
results with a finer mesh. By observing the results of the simulations and comparing with the
calculated ones, it was understood that they were demonstrating a non-elastic behavior of the
concrete, as expected, the displacements seen were greater than those calculated. When seeing
that the tension in the steel cables did not reach the yield limit and that the main tensions were,
in some cases, above the concrete limit, such reasons lead to believe that the crushing of the
concrete may have occurred and that the element used did not managed to demonstrate such
behavior. Finally, it was concluded that the tool used can be used for the proposed objective and
new works were suggested.

Keywords: Finite element method. Simulation of Structure. Bridge. Ansys.
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1 INTRODUÇÃO

Entre as principais obras de Arte da Engenharia Civil temos as Pontes e os Viadutos
que são construídos principalmente para vencer obstáculos, tendo um papel fundamental no
transporte terrestre, fomentando a economia, pois tornam as ligações entre diferentes locais mais
fáceis e rápidas (MAKSYMOWICZ, 2008). No Brasil as pontes e viadutos são elementos com
importância essencial para o transporte de cargas em estradas rodoviárias, podendo-se afirmar
serem imprescindíveis para o escoamento da produção, sendo responsáveis por fazerem a ligação
nos pontos críticos das estradas, garantindo uma trajetória de continuidade (Oliveira,1999).

Segundo Laner (2001)

pode-se afirmar que as pontes e viadutos das grandes cidades são verdadeiros
equipamentos urbanos, indispensáveis para a vida cotidiana de suas populações
porque, antes de mais nada, definem os principais escoamentos de vias, articu-
lando cruzamentos de grandes avenidas, encurtando caminhos e compensando
acidentes geográficos.

Assim ver-se que estas obras são de extrema importância para a sociedade, tanto nas cidades
quanto nas ligações entre elas, sendo essencial mantê-las com desempenho esperado durante sua
vida útil.

Segundo Vitório (2006) os órgãos públicos têm uma cultura apenas pela execução das
obras, em seus diferentes níveis, sem levar em conta as questões relacionadas com a conservação
dessas estruturas, essa deficiência leva a falta de políticas e estratégias destinadas a conservação,
o que leva a realização da manutenção tardia nas obras, tornando os reparos muito mais onerosos,
já que a Lei de Sitter mostra que os custos com correção são cinco vezes aqueles que teria caso
houvesse manutenção preventiva.

Havendo uma tendência natural ao desgaste das estruturas, temos que as ações preventivas
têm uma grande importância para que se possa monitorar as condições das obras de arte, evitando,
através da manutenção, que os problemas existentes evoluam (LOURENÇO et al., 2009). Nesse
mesmo sentido Maksymowicz (2008) diz que durante a vida de serviço, de uma ponte ou viaduto,
vários mecanismos de degradação ocorrem resultando nos mais variados tipos de defeitos,
levando a redução das condições de serviço, principalmente devido a falta de manutenção
adequada, ele ainda diz que as condições dessas obras precisam ser avaliadas, de forma a dar
aos órgãos responsáveis uma base para a tomada de decisões racionais sobre as manutenções
e serviços adicionais a serem considerados na estrutura, assim como para reservar os recursos
necessários para tal.

A simulação da estrutura é uma forma de conhecer o seu comportamento ao longo do
tempo, com isso pode-se buscar determinar se há um tempo de intervenção ideal, de tal forma
que se possa minimizar os custos operacionais garantido a vida útil da estrutura.

O método dos elementos finitos (MEF) pode ser encarado de duas maneiras distintas, a
primeira é do ponto de vista do utilizador, que recorre ao uso de um aplicativo comercial baseado
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no MEF, e a segunda é do ponto de vista do programador, que desenvolve o aplicativo para
uso próprio ou de outros. Neste trabalho foca-se no ponto de vista do utilizador, que deve ter
conhecimento sobre os processos físicos e mecânicos que se pretende estudar, além do aplicativo
a ser utilizado. Foi utilizado o conjunto de aplicativos ANSYS WORKBENCH para este trabalho,
buscando simular parâmetros estruturais, funcionais e de durabilidade em vigas de pontes e
viadutos, relacionando-os a mecanismos de perdas das características das peças estruturais, de
modo a estabelecer uma relação entre a resistência e o tempo utilizando o programa mencionado,
que é uma ferramenta que implementa o método dos elementos finitos. Esse tipo de simulação
pode ser usado para se ter uma ideia sobre o comportamento atual da estrutura, possibilitando
a determinação de um tempo de desativação ou manutenção quando houver constatação dos
ataques simulados. Utilizar um programa de simulação, como o ANSYS, é uma maneira de
economizar verba e tempo, além de permitir uma visualização de características reais da estrutura.

Pode-se também buscar dados de regiões semelhantes ao do local de construção de uma
obra de arte e utilizar a simulação para determinar o tempo de inspeção da estrutura com certa
margem de segurança. Na hipótese de se encontrar algum manifestação na inspeção, pode-se
realizar novas simulações para-se determinar a resistência residual, deformação e deslocamento
da estrutura de forma a definir alguma restrição de uso da estrutura, como redução de velocidade
e redução da capacidade de carga do veículos que por ela trafegam.

Como hipótese para o trabalho, acredita-se que é possível utilizar um programa de
elementos finitos para modelar uma estrutura com alguma manifestação patológica e obter uma
boa aproximação da estrutura real.

No trabalho analisou-se a viga de centro do tabuleiro do vão central da ponte rodoviária
sobre o Rio Sousa, na região metropolitana da cidade de Porto em Portugal, as informações
foram obtidas pelo trabalho de Sousa (2004). Optou-se por esta estrutura porque ele desenvolveu
uma simulação numérica e os seus resultados poderiam ser utilizados para comparação.

1.1 Justificativa

Durante a vida útil de uma ponte muitos mecanismos de degradação ocorrem, o que
resulta em vários defeitos, ocasionando a redução das condições de serviço, isso acontece porque
há uma tendência natural de deterioração das estruturas, devido a um processo ineficiente de
manutenção (LOURENÇO et al., 2009). E Fusco (1989 apud OKIMOTO, 1997) referindo-se a
estruturas de madeira, diz que as catástrofes nunca decorrem de erro na etapa de dimensionamento
(cálculo estrutural) e são consequência, sim, de deficiência nas etapas de concepção, detalhamento
ou manutenção das estruturas. Logo é necessário conhecer as alterações que ocorrem durante a
vida útil das estruturas devido a ação dos agentes externos.

Desta forma o trabalho busca contribuir, como parâmetro social e técnico, mostrando
a utilização de uma ferramenta de análise por elementos finitos para a simulação de uma
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manifestação patológica, ataques por cloretos, na estrutura. Esse tipo de simulação pode ser feita
para definir-se um tempo de inspeção nas obras de arte, afim de evitar o desperdício de verbas
públicas e melhorar o planejamento das inspeções.

Do ponto de vista técnico-científico o trabalho contribui para o entendimento das intera-
ções entre os diferentes componentes de uma estrutura, quando elas não estão nas condições de
projeto, e como elas trabalham conjuntamente para a estabilidade da estrutura, como no caso da
falta de aderência entre as barras e o concreto devido aos produtos de corrosão.

1.2 Objetivo

O trabalho busca simular os efeitos do agente degradante em uma longarina de uma
ponte de concreto protendido, com intuito de estabelecer o comportamento estrutural dela ao
longo desse período de tempo.

1.2.1 Objetivos específicos

Têm-se os seguintes objetivos:

• Definir as propriedades dos materiais para serem utilizadas com os elementos do modelo
computacional que simulem as propriedades do concreto e do aço;

• Mostrar graficamente as relações entre os parâmetros de resistência da estrutura e o tempo,
com ataques e sem ataque;

• Comparar diferentes abordagens de modelagem das armaduras.

1.3 Estrutura do Trabalho

De início, foi realizado uma revisão do estado da arte sobre o tema tanto na literatura
nacional como na internacional. Desta revisão elaborou-se o texto que está dividido em 4 partes,
Introdução, revisão da literatura, metodologia, resultados e conclusão. A introdução destaca os
pontos iniciais do trabalho, os objetivos e as hipóteses, logo após temos a revisão de literatura
para familiarizar o leitor com o tema do trabalho, descreve-se o concreto estrutural, a importância
dele nas construções de pontes, busca-se definir os agentes agressivos do mesmo, os aspectos
que melhoram a sua durabilidade, e após isso faz-se uma introdução ao método dos elementos
finitos e ao ANSYS Workbench. No capítulo 3 tem-se a metodologia, onde descreve-se o
objeto de estudo, como o mesmo será modelado numericamente, no capítulo 4 os resultados
são apresentados e uma análise destes. No 5 está a conclusão sobre o trabalho. No apêndice
apresenta-se um passo a passo de como realizar a simulação e por fim tem-se os anexos com os
códigos necessários para realizar a simulação.
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2 REVISÃO DE LITERATURA

Neste capítulo busca-se introduzir os materiais utilizados nas pontes, e posteriormente
faz-se a introdução ao concreto e suas caraterísticas, os termos utilizados nas normas, discorre-se
sobre os agentes de agressão mais comuns ao concreto e por fim uma introdução ao método dos
elementos finitos e ao pacote de aplicativos ANSYS.

2.1 Tipos de pontes

As pontes podem ser classificadas segundo o tipo de material utilizado para a sua
construção e os 5 principais tipos de pontes, segundo o material, podem ser vistas a seguir:

• As pontes de madeira – construídas em madeira estrutural, são atraentes economicamente
e tem um viés da sustentabilidade. No Brasil, essas pontes são apenas utilizadas na
construção de pontilhões para a travessia de riachos e córregos ou em estradas das zonas
rurais com um pequeno volume de tráfego e cargas, com exceção na região amazônica,
onde a grande quantidade desse material faz com que seja predominante na construção de
pontes (VITÓRIO, 2002).

• Pontes de pedra – utilizam pedras naturais para a construção das pontes, as pedras
geralmente têm resistência excelente a compressão podendo ser usada em elementos como
pilares e abóbodas, e também resistem bem a ação do tempo. No Brasil, as principais
pontes desse tipo foram construídas no estado de minas gerais, que tem a cidade com o
maior número de pontes de pedra. Nos dias atuais, ainda se utiliza o material na forma
de alvenaria de pedra argamassada na construção dos encontros de determinados tipos de
pontes. Ainda existem na malha rodoviária de Pernambuco vários exemplares de pontes
com décadas de uso, que têm os seus encontros e alas de alvenaria de pedra em excelente
estado(VITÓRIO, 2002).

• Pontes metálicas – as pontes metálicas surgiram no final do século XVIII, sendo as
primeiras feitas de ferro fundido. Após isso, por causa de demandas para suporte de cargas
maiores da época, começaram a utilizar o ferro forjado e o aço. Começando o período
das grandes pontes tipo pênseis e em treliças metálicas. Elas passaram a ser largamente
utilizadas a partir do final do século XIX, com destaque para as pontes pênseis e depois da
segunda Guerra Mundial começaram a ser construídas as pontes estaiadas (CHATTERJEE,
2008).

• Pontes de concreto armado – quando começaram a utilizar o concreto como material de
construção nas pontes, ele apenas substituía as pedras. Após isso o concreto armado foi
inicialmente usado nas lajes dos tabuleiros e logo depois nas nervuras dos arcos, quase
dez anos depois começaram a ser construídas as pontes em vigas e pórticos. A pesquisa
realizada por SAMCO (2003) sobre os tipos de pontes em vários países da Europa chegou
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ao resultado da tabela 1, como pode ser visto o maior grupo é de pontes de concreto armado,
com 79% do total de pontes, e 40% dessas pontes são de concreto armado protendido
pré tracionado. Assim pode-se ver que o concreto armado é um dos principais materiais
de construção das pontes, e devido ao melhoramento e aprimoramento do seu controle
tecnológico, alcançou um elevado nível de qualidade. A utilização de concreto armado
têm limitações segundo o vão a ser vencido, de tal forma que ele é economicamente viável
para vãos máximos de até 20 metros, essas limitações para a sua utilização em grandes
vãos nas superestruturas de pontes foram superadas com o advento do concreto protendido,
mas ele ainda continua a ser utilizado nas fundações e mesoestruturas (VITÓRIO, 2002).

Tabela 1 – Tipos de pontes na Europa.

Tipos de Pontes Quantidade Porcentagem
Concreto Armado 33987 78%

Pré tracionado 17281 40%
Pós tencionado 225 1%

Concreto 940 2%
Composto 1271 3%
Metalicas 3887 9%
Madeira 792 2%
Pedras 1376 3%
Outros 1154 3%

Fonte: Adaptado de SAMCO (2003).

• Pontes de concreto protendido – a diferença básica de concreto protendido em relação
ao concreto armado é que no protendido introduz-se na estrutura um estado de tensões
iniciais o que causa aumento da sua resistência às solicitações, possibilitando a execução
de grandes vãos livres com expressiva redução do peso próprio. A sua competitividade
e principal vantagem em relação ao concreto armado convencional é a possibilidade de
vencer vãos bem maiores com redução de altura das vigas e das quantidades necessárias
de concreto e aço, pela utilização eficiente de materiais de alta resistência (CHOLFE;
BONILHA, 2018).

O objeto de estudo do trabalho são as estruturas feitas com concreto protendido, de forma
que os outros tipos foram apresentados apenas para ciência do leitor.

2.2 Concreto

Nesta seção, e antes de serem abordadas outras conceitos sobre as estruturas, é necessário
demonstrar, mesmo que de forma sucinta, os materiais existentes na estrutura de um concreto
estrutural.
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O concreto é um material amplamente utilizado na construção civil, ele é composto por
cimento, água, agregado miúdo e agregado graúdo, e pode conter adições e aditivos químicos,
que tem por finalidade melhorar ou modificar alguma propriedade do mesmo, como calor de
hidratação ou resistência a determinados tipos de ataques.

2.2.1 O cimento

No Brasil são fabricados diversos tipos de cimentos, resultando em características me-
cânicas, físicas e químicas variadas. Assim o tipo de cimento adequado a um determinado uso
depende do bom conhecimento dos vários tipos disponíveis.

Segundo Souza e Ripper (1998), a capacidade de resistir à agentes externos, como
cloretos, dióxido de carbono, etc. está relacionada às características físicas e químicas do
cimento, como expansibilidade, presença de cal livre, óxido de magnésio, finura, etc.

E ainda de acordo com eles os tipos de cimento que são produzidos no Brasil são: o
cimento Portland comum, cimento Portland comum com adições, cimento Portland de alto-forno,
cimento Portland composto, cimento Portland pozolânico e cimento Portland de alta resistência
inicial. E ainda nessas categorias podem ser fabricados cimentos resistentes a sulfatos (SOUZA;
RIPPER, 1998).

No quadro 1 temos um resumo dos tipos de cimento, as numerações 25, 32 e 40 repre-
sentam as resistências mínimas em MPa.

Battagin (2011) faz uma equiparação dos cimentos brasileiros com os europeus que pode
ser vista no quadro 2.

Já os principais compostos do cimentos podem ser vistos no quadro 3, ainda temos
outros componentes presentes em menores proporções como os álcalis (Na2O, K2O), o óxido de
magnésio(MgO) e a cal livre (CaO) (FUSCO, 2008; SOUZA; RIPPER, 1998).

2.2.2 Agregados graúdos e miúdos

Os agregados são importantes tando do ponto de vista técnico como econômico, pois são
mais baratos do que o cimento e exercem influência sobre algumas características importantes
do concreto como redução da retração e o aumento da resistência mecânica, podendo chegar a
contribuir com 80% do peso e 20% do custo do concreto estrutural (BAUER, 2011; SOUZA;
RIPPER, 1998).

Os agregados graúdos devem ser inertes para evitar reações do tipo álcalis-agregados
e devem ter o teor de umidade controlado já que isso altera o fator água/cimento. Um outro
ponto é a composição granulométrica do mesmo, pois ela têm influência sobre a compacidade e
a resistência do concreto, além de influenciar na trabalhabilidade do mesmo. Uma boa graduação
é um dos fatores de redução da quantidade de cimento empregado para atingir um concreto com
boas propriedades (FUSCO, 2008).
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Quadro 1 – Tipos de cimento.

Designações Classes Norma A B N T

Cimento Portland comum
CP 1-25
CP 1-32
CP 1-40

NBR – 5732

Cimento Portland comum
(com adições)

CP I-S-25
CP I-S-32
CP I-S-40

NBR – 5732

Cimento Portland composto
(com escória)

CP II-E-25
CP II-E-32
CP II-E-40

NBR – 11578

Cimento Portland composto
(com pozolana)

CP II-Z-25
CP II-Z-32
CP II-Z-40

NBR – 11578

Cimento Portland composto
(com filer)

CP II-F-25
CP II-F-32
CP II-F-40

NBR – 11578

Cimento Portland de alto-forno
CP III-25
CP III-32
CP III-40

NBR – 5732

Cimento Portland pozolânico
CP IV-25
CP IV-32 NBR – 5735

Cimento Portland de alta resistência inicial CP V-ARI NBR – 5733

Fonte: Souza e Ripper (1998).

Pode-se utilizar também agregados miúdos nos concretos, geralmente areias ou cascalho,
outros tipos também podem ser utilizados como escórias siderúrgicas desde que haja adequa-
bilidade demostrada em laboratório. Eles devem estar isentos de matérias orgânicas, siltes e
argilas. A granulometria dos agregados miúdos também tem influência na qualidade do concreto.
Outro ponto é a sua densidade, se ela for baixa significa que o agregado é poroso e sem muita
resistência (BAUER, 2011).

2.2.3 Água e aditivos

A água é um dos componentes mais importantes do concreto, a quantidade utilizada no
concreto ou fator água/cimento, influência a resistência do mesmo. Deve-se tomar cuidado para
não se utilizar águas contaminadas, com cloretos ou matéria orgânica, na fabricação de concretos
estruturais, pois estes podem colaborar para instalação e o desenvolvimento do processo de
corrosão das armaduras(SOUZA; RIPPER, 1998).

Para Bauer (2011), os aditivos são todos os materiais não indispensáveis a composição e
qualidade do concreto e Fusco (2008), diz que é necessário um controle rigoroso da composição
química dos mesmos, e que deve ser rigorosamente proibida a aplicação de aditivos no concreto
que possuam cloretos nas suas composições.



21

Quadro 2 – Equivalência de cimentos.

Denominação
Cimento Brasileiro Cimento Europeu

Norma
ABNT Tipo Sub-tipo

Tipo
(EN-197-1)

Cimento Portland
Comum

NBR 5732 CP I
CP I CEM I

CPI-S CEM I

Cimento Portland
Composto

NBR 11578 CP II

CPII-F CEM II/A-L

CPII-E
CEM II/A-S
CEM II/B-S

CPII-Z

CEM II/A-P
CEM II/A-V
CEM II/A-Q
CEM II/A-T

Cimento Portland de
Alto-forno NBR 5735 CP III - CEM III/A

Cimento Portland
Pozolânico NBR 5736 CP IV -

CEM IV/A
CEM IV/B

Cimento Portland de
Alta Resistência Inicial NBR 5733 CP V-ARI - CEM I

Fonte: Battagin (2011).

Quadro 3 – Principais compostos do cimento.

Compostos
Notações Químicas dos

Cimentos
Notações Químicas

Condensadas
Silicato Tricálcico 3 CaO ·SiO2 C3S
Silicato Bicálcico 2 CaO ·SiO2 C2S

Aluminato Tricálcico 3 CaO ·Al2O3 C3A
Ferro-Aluminato Tetracálcico 4 CaO ·Al2O ·Fe2O3 C4AF

Gipsita CaSO4 · 2 H2O C5H2

Fonte: Souza e Ripper (1998).

2.2.4 Concreto estrutural

O concreto simples tem uma boa resistência a compressão e uma resistência a tração bem
baixa, geralmente menor do que 1/10 da resistência a compressão, essa característica indesejada
do concreto foi contornada por meio da utilização de barras de aço bem posicionadas (armaduras)
de forma a resistir aos esforços de tração no concreto, ao material resultante dessa combinação
dar-se o nome de concreto estrutural (FUSCO, 2008).

De acordo com Pinheiro, Muzardo e Santos (2016), o concreto estrutural tem algumas
vantagens:

• Economia de construção – Como se utiliza uma alto volume agregados de regiões próximas
a obra os custos são menores em comparação a outras alternativas;
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• Economia na manutenção – Reduzidos gastos de manutenção, quando a estrutura é bem
projetada e adequadamente construída;

• Resistência a agressões químicas do ambiente – Se adequadamente entendido, ele pode
ser usado nos mais variados ambientes já que possuí características semelhantes as rochas
naturais;

• Resistência a agressões físicas do ambiente – A sua resistência ao fogo é boa, além de
maior resistência a choque e vibrações;

• Flexibilidade de forma – Pode-se moldar o concreto a forma que se desejar.

O concreto estrutural pode ser classificado em dois tipos a depender do tipo de armadura
utilizado. Quando não se coloca um estado de tensões iniciais nas armaduras dar-se o nome
de concreto armado, já quando se adiciona um estado de tensões iniciais chama-se concreto
protendido (ABNT, 2014).

Segundo Fusco (2008), os aços utilizados no concreto armado têm resistências de
escoamento de até 500 ou 600 MPa, já no concreto protendido se empregam aços com resistências
de escoamento até 2000 MPa.

As estruturas de concreto protendido podem ainda ser classificadas dependendo de
quando é aplicado a tensão inicial, a tensão de protensão. Quando a tensão é aplicada antes do
lançamento do concreto, dar-se o nome de concreto protendido pré-tracionado, e quando aplicada
depois da cura do concreto, chama-se concreto protendido pós-tracionado, o pós-tracionado pode
ser aderente e não aderente (MUTHU et al., 2016).

2.3 Desempenho das estruturas

As pontes e outras obras de arte podem estar expostas a vários processos de deterioração,
que dependem da classe de agressividade do ambiente em que estão inseridas, do sistema estrutu-
ral, do tipo de material utilizado, como também a falta de manutenção (SILVA, 2012). A ABNT
(2014) define três requisitos de qualidade para as estruturas de concreto armado, a capacidade
resistente, o desempenho em serviço e a durabilidade. A capacidade resistente é basicamente a
segurança à ruptura da estrutura, o desempenho em serviço consiste na capacidade da estrutura de
manter-se em plenas condições de utilização durante sua vida útil sem comprometimento parcial
ou total da estrutura e a durabilidade é a capacidade da estrutura para resistir as influências do
ambiente que ela está inserida (ABNT, 2014).

2.3.1 Vida útil

Para Silva (2012, p. 9), “a vida útil é o período de tempo durante o qual uma estrutura
mantém as suas características de funcionalidade, segurança, resistência e aspeto exterior, para
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as quais foi projetada”. Já Tuutti (1982) definindo um modelo para determinação da vida útil de
estruturas de concreto armado, divide a vida útil da estrutura, em relação a corrosão da armadura,
em dois estágios Iniciação e Propagação. Na figura 1 tem-se a representação do modelo, pode-se
observar dois intervalos bem distintos no primeiro, a Iniciação, ocorre a penetração dos agentes
agressivos até alcançar a armadura e provocar a despassivação da mesma, no segundo é quando
o agente agressivo já alcançou a armadura e há um processo de corrosão, em geral se considera
que nesse período a corrosão desenrola-se em uma velocidade constante.

De acordo com Noval (2009), a vida útil é até o momento em que ocorre um grau
inadmissível de corrosão nas armaduras, e ainda de acordo com ele o Eurocode 2 não admite
nenhum grau de corrosão, sendo portanto a vida útil o período de iniciação.

Figura 1 – Modelo de corrosão do aço no concreto.

Fonte: Tuutti (1982).

Seguindo o pensamento de Silva (2012) com o modelo de Tuutti (1982), infere-se que se
a há necessidade de manutenção ou intervenção na estrutura significa que sua vida útil já acabou.

2.3.2 Corrosão

Corrosão é um termo usado para designar a deterioração de um metal por reação química
ou eletroquímica, os metais mais comumente usados são produzidos a partir de seus óxidos,
de forma que sua forma refinada é menos estável do sua forma natural e dada as condições
apropriadas ele retorna a sua forma de óxidos, em outras palavras ele corroí (PODOLNY JR,
1992).
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O aço no concreto está em uma solução alcalina, com pH entre 13 e 14. Um meio
deste tipo faz com que o aço seja passivado, isso significa que pela dificuldade dos produtos de
corrosão para se dissolverem é formada na superfície do aço uma fina camada deles com uma
permeabilidade tão alta que a taxa de corrosão se torna praticamente nula (TUUTTI, 1982).

Mas quando ocorre corrosão no concreto, quer dizer que de alguma forma o meio foi
modificado a ponto de haver uma despassivação do aço, isso pode ocorrer de maneira localizada
ou generalizada, mas é necessário um tempo para que o inicio do processo de corrosão ocorra
(TUUTTI, 1982).

Segundo Tuutti (1982), há dois casos principais que podem iniciar esse processo, o
primeiro é a presença de cloretos, esses cloretos podem atacar localmente a camada passivadora
em um meio alcalino, e o segundo é a presença de dióxido de carbono (CO2), que tende a tornar
o pH do meio neutro, este processo é conhecido como carbonatação. Estes também são citados
pela ABNT (2014), item 6.3.3.1 e 6.3.3.2, sendo considerados os mecanismos preponderantes de
deterioração das armaduras, tanto das passivas quanto das ativas.

A corrosão do aço leva a redução da área de aço, diminuindo a capacidade de absorver
tensões no concreto. Ademais os produtos da corrosão se acumulam na superfície do aço e por
terem volume maior do que o do aço, acabam por introduzir tensões no cobrimento do concreto,
o que pode levar a fissuras paralelas as armaduras (TUUTTI, 1982).

Em adição ao perda de seção transversal também ocorre a diminuição dos limites do aço
que segundo o trabalho de Du, Clark e Chan (2005), é uma variação linear regido pela equação
2.1.

f = (1,0− 0,005Qcorr)f0 (2.1)

Onde f é tensão de escoamento, f0 é a tensão de escoamento antes da corrosão, e Qcorr é a
porcentagem de corrosão no local.

Vale ainda citar outros dois tipos de corrosão especificas do concreto protendido segundo
Podolny Jr (1992), o primeiro é a corrosão sob tensão (CBS), sendo um tipo de corrosão
altamente localizada, que produz fissuras devido a presença simultânea de corrosão e uma força
de tensão, eventualmente essas fissuras levam a um rompimento frágil, sem ductilidade. O outro
é a fragilização por hidrogênio, ainda de acordo com o mesmo autor, essa fragilização ocorre
quando hidrogênio atômico penetra na estrutura do metal e forma uma molécula de hidrogênio
produzindo uma pressão interna no metal, essa absorção de hidrogênio atômico ocorre devido
o carregamento catódico que ocorre em ambiente corrosivo onde o aço está ligado a um metal
anódico, e em virtude disso fissuras podem-se formar e se combinadas com altas tensões externas
podem levar ao colapso abrupto da estrutura.
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2.3.3 Durabilidade

Conforme Fusco (2008), a durabilidade do concreto depende de sua fabricação com
materiais não expansivos e de sua capacidade de resistir às agressões provenientes do meio
externo. E ainda segundo ele, quase todos os mecanismos de agressão ao concreto dependem da
presença e do transporte dos elementos externos de agressão pelo interior do concreto, através
dos poros e fissuras, além da existência dos seguintes fatores cruciais:

• disponibilidade de água no interior da massa de concreto;

• disponibilidade de oxigênio do ar.

Em relação ao ambiente que estrutura está inserida a ABNT (2014), traz várias tabelas
para a definição da resistência característica do concreto, para a relação água/cimento e para
o cobrimento necessário. Esses aspectos influenciam nos itens essenciais descritos por Fusco
(2008), ajudando a controlar a quantidade de água no interior do concreto, sua permeabilidade e
sua porosidade.

2.4 Despassivação das armaduras

Nesta seção será visto como acontece a despassivação das armaduras pela ação de
cloretos e pela carbonatação.

2.4.1 Despassivação por carbonatação

De acordo com Tuutti (1982), o concreto contém várias substâncias que fornecem
soluções básicas, como o óxido de cálcio (CaO), óxido de sódio (Na2O) e o óxido de potássio
(K2O). Por este motivo a solução porosa do concreto tem alta concentração de hidróxidos, daí o
pH alto.

O sódio e o potássio são mais solúveis do que cálcio, e estão praticamente dissolvidos na
solução dos poros do concreto, desta forma pouca quantidade de hidróxido de cálcio (Ca(OH)2)
estão dissolvidas na solução. Todavia o óxido de cálcio é encontrado em maior quantidade, e
como resultado disso uma grande parcela de Ca(OH)2 encontram-se cristalizadas nos poros.
Assim o processo de carbonatação é lento no concreto principalmente devido a impermeabilidade
do mesmo, dessas reservas de hidróxidos e da baixa concentração de CO2 no ar (TUUTTI, 1982).
Já Bauer (2011), diz que o CO2 penetra pelos poros até a frente de carbonatação e que esse
processo é cada vez mais difícil, uma vez que o carbonato de cálcio (CaCO3) fecha os poros e
pela falta de água para a dissolução do Ca(OH)2.

E Tuutti (1982), ainda afirma que a reação que provoca a despassivação, diminuindo o
pH da solução para valores abaixo de 9 é:

Ca(OH)2 + CO2 −−→ CaCO3 + H2O
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ele também diz que essa reação tem vários estágios e reações intermediários, entretanto um
dos produtos finais sempre é o carbonato de cálcio, já Bauer (2011), diz que, em condições
excepcionais, a água liberada na reação pode não evaporar e dissolver o hidróxido de cálcio,
fazendo com que a reação tenha continuidade.

De acordo com Bauer (2011), a carbonatação vista em microscópio tem cor clara e a
pasta de cimento alcalino escura e que os principais fatores que influenciam o seu aparecimento
são o estado da pasta de cimento endurecida, a disposição dos poros e a quantidade de água
retida.

Tanto Tuutti (1982) como Bauer (2011) descrevem modelos para a determinação da
profundidade de carbonatação no concreto, conhecida também como frente de carbonatação(Y).
Esses modelos utilizam-se de uma constante k (coeficiente de carbonatação), que depende do
tipo de concreto, e do tempo para definir a profundidade.

Y = k
√
t (2.2)

Já Fusco (2008) dá a tabela 2, para a estimação da velocidade de carbonatação conside-
rando o concreto em perfeita condição de integridade.

Tabela 2 – Velocidade de carbonatação.

Profundidade de
carbonatação (cm)

Tempo
(anos)

1 5
1,5 20
2,0 50
2,5 100

Fonte: Adaptado de Fusco (2008).

2.4.2 Despassivação por cloretos

Segundo Fusco (2008), os íons cloreto podem adentrar no interior do concreto por
difusão, por meio da água contida nos poros totalmente saturados ou parcialmente ou ainda que
esses cloretos podem ter origem na água do mar ou de poluentes ambientais. Já Crauss (2010),
diz que a contaminação por íons cloreto pode ser pela própria composição do concreto ou em
componentes como agregados e aditivos aceleradores de pega que contenham CaCl2.

Diferentemente dos que acontece na carbonatação, os íons cloretos são especialmente
agressivos, pois podem atacar as armaduras mesmo em condições de alta alcalinidade da solução
dos poros e como eles não são consumidos no processo de corrosão, permanecem disponíveis
para novas reações (CRAUSS, 2010).

De maneira simplificada as reações que controlam a corrosão, por íons cloreto, podem
ser vistas a seguir :
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Fe3+ + 3 Cl– −−→ FeCl3

FeCl3 + 3 OH– −−→ 3 Cl– + Fe(OH)3

Como pode ser visto, os íons cloretos funcionam como um catalisador e, devido a isso,
a taxa de corrosão é maior mesmo com pequenas quantidades disponíveis desse íon (FUSCO,
2008; CRAUSS, 2010).

De acordo com Bertolini et al. (2013), a penetração de cloretos do ambiente produz
um perfil no concreto caracterizado por altos valores de cloretos próximos a superfície e um
decaimento conforme o aumento da profundidade. Em geral esse perfil pode ser aproximado
pela segunda lei de difusão de Fick, dados experimentais mostram que o perfil de cloretos pode
ser modelado matematicamente com boa aproximação pela equação 2.3:

Cx = Cs(1− erf(
x

2
√
Dapp · t

)) (2.3)

Onde Cx é a concentração total de cloretos a uma distância x da superfície do concreto depois
de um tempo t de exposição, Dapp é o coeficiente de difusão aparente dos cloretos e Cs é a por-
centagem de cloretos na superfície em relação a massa de cimento ou do concreto (BERTOLINI
et al., 2013).

Semelhantemente Hackl e Kohler (2016), baseados no modelo de Tuutti (1982) de
iniciação e propagação, utilizaram as equações 2.4, 2.5 e 2.6 para determinar se a concentração
de cloretos, a uma distância xcl da superfície, é crítica.

∂Ccl
∂t

= Dcl
∂2Ccl
∂x2cl

(2.4)

Onde Ccl é a concentração de cloretos a uma distância xcl da superfície do concreto depois de
um tempo t de exposição e Dcl é o coeficiente de difusão dos cloretos.

A solução dessa equação diferencial é:

Ccl(xcl, t) = Cee
s,cl

(
1− erf

(
xcl

2
√
Dcl.t

))
(2.5)

erf() é a função erro, e Dcl pode ser calculado como:

Dcl = keee,cl.kt,cl.k
tcur
c,cl .D

w/c
0 .

(
t0,cl
t

)nee
cl

(2.6)

keee,cl é um parâmetro do ambiente, kt,cl parâmetro do teste, ktcurc,cl é o parâmetro de execução, D0 é
o coeficiente empírico de difusão, t0,cl é o tempo de referência e ncl o fator de idade. Quando o
valor crítico é alcançado, se houver armadura na distância xcl então o processo de corrosão será
iniciado nela.

Já Andrade (2001), em sua tese de doutorado também desenvolveu um modelo que
representa o avanço da frente de penetração de cloretos em função do tempo no concreto, o
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modelo é definido pela equação 2.7.

y = 7,35 · UR
0,7 · T 0,1 · Cl0,7

K1 · fck ·K2 · (1 + Ad)0,2
·
√
t (2.7)

Onde y é a posição da frente de penetração de íons cloreto em mm, UR é a umidade relativa média
do ambiente em porcentagem, T é a temperatura média ambiental em °C, Cl é a concentração
superficial de cloretos em porcentagem sobre a massa de cimento, K1 é um valor tabelado que
varia em função do tipo de cimento empregado na fabricação do concreto, fck é a resistência
característica do concreto à compressão em MPa, K2 é o fator que varia em função do tipo adição
empregada na fabricação do concreto, Ad é o teor de adição no concreto em porcentagem sobre
a massa de cimento e t é o tempo em anos.

2.4.3 Modelo de deterioração

O modelo de corrosão localizada, utilizado no trabalho foi inicialmente desenvolvido
em armaduras passivas, todavia este comportamento também acontece nas armaduras ativas, e
os trabalhos de Belletti et al. (2020), Podolny Jr (1992) e Darmawan e Stewart (2007) afirmam
isso. Inclusive no trabalho de Darmawan e Stewart (2007), eles chegam a conclusão que a maior
possibilidade de colapso devido a corrosão em estruturas de concreto protendido é por causa da
tensão de escoamento ser alcançada, assim não foi considerado a fragilização ou fissuras das
armaduras ativas, que levam a um rompimento frágil das mesmas. O modelo utilizado é descrito
nos próximos parágrafos.

Em estruturas que estão no processo de propagação, modelo de Tuutti (1982), ocorre uma
diminuição do diâmetro das barras devido o processo de corrosão, nessas estruturas expostas
a taxa de corrosão pode variar de décimos de micrômetros por ano até um milimetro por ano,
dependendo da umidade relativa do ar e temperatura, e segundo Bertolini et al. (2013), esses
valores foram observados em estruturas como tabuleiros de pontes, muros de arrimo e pilares
nos alpes suíços. Ele ainda afirma que em locais de clima tropical a taxa pode ainda ser maior.

A norma ASTM (2009), têm uma fórmula para conversão entre taxa de corrosão e
densidade corrosão, manipulou-se os elementos da fórmula, da referida norma, para chegar a
equação 2.8, onde CR é a taxa de corrosão em µm/ano, ρ é a densidade em g/cm3, Icorr é a
densidade de corrosão em µA/cm2, M é a massa molar, n é o número de elétrons consumidos e
K é 3,27 mm.g

µA.cm.ano
.

CR = K · Icorr
ρ
· M
n

(2.8)

Colocando a equação 2.8 em função da taxa de corrosão chega-se a equação 2.9. Os
valores para o ferro/aço são M=55,85, ρ=7,88 g/cm3 e n=2.

Icorr =
CR.ρ

K
· n
M

(2.9)



29

Já em Bertolini et al. (2013), tem-se uma conversão mais direta, ele afirma que 0,1
µA/cm2 corresponde a uma taxa de corrosão de 1,17 µm/ano. Ao utilizar o valor de 0,1 µA/cm2

na equação 2.9 chega-se a uma taxa de corrosão de 1,16 µm/ano, isso mostra que a equação tem
uma precisão maior.

Du, Clark e Chan (2005) dão as equações 2.10 e 2.11, onde Icorr é a densidade de corrosão
em µA/cm2, d é o diâmetro inicial da barra, ds é o diâmetro da barra corroído, t é o tempo em
anos e Qcorr é a porcentagem de corrosão. Essas equações serão utilizadas para alteração dos
parâmetros físicos das barras na região onde simular-se-á os efeitos da corrosão.

Qcorr = 1−
(
ds
d

)2

(2.10)

Qcorr = 0,046 · Icorr
d
· t (2.11)

2.5 Equações para concreto protendido

As equações nesta seção foram retiradas do livro de Muthu et al. (2016). O momento
resistente superior é dado na equação 2.12 e o momento resistente inferior está na equação 2.13.

Zt =
Ixx

120− ȳ
(2.12)

Zb =
Ixx
ȳ

(2.13)

Já a tensão no topo de uma viga pode ser calculada com a equação 2.14 e a na base com a
equação 2.15.

σt =
P

A
− P · e

Zt
+
Mg

Zt
+
Mq

Zt
(2.14)

σb =
P

A
+
P · e
Zb
− Mg

Zb
− Mq

Zb
(2.15)

Onde ȳ é a altura do centro de gravidade, Ixx é o momento de inercia, P é força de protensão,
A é a área da seção da viga, e é a excentricidade da armadura de protensão, Mq é o momento
devido as cargas variáveis, Mg é o momento devido as cargas permanentes.

O deslocamento (flecha) negativo devido a protensão é calculado pela equação 2.16.

δp =
P · e · l2

8EI
(2.16)

A flecha devido a carga distribuída é obtida usando a equação 2.17, já para carga pontual no
meio do vão usa-se a equação 2.18, para a carga pontual a uma distância b do apoio utiliza-se a
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equação 2.19. Onde l é o vão da viga, w é a carga distribuída, F é a força pontual, b é a menor
distância a um dos apoios, E é modulo de elasticidade do concreto e I é a inercia da seção

δdmax =
5 · w · l4

384EI
(2.17)

δdpmax =
F · l3

48EI
(2.18)

δd2max =
F · b(l2 − b2) 3

2

(9
√

3) · l · EI
(2.19)

O deslocamento total pode ser alcançado somando os diferentes tipos deslocamento que a
estrutura está sujeita, lembrando que o efeito da protensão é negativo. Vale salientar que segundo
Muthu et al. (2016), essas equações são elásticas, ou seja o material tem comportamento linear,
curva tensão deformação linear obedecendo a lei de Hooke, as seções transversais permanecem
planas normais ao eixo da barra quando esta se deforma. Ele ainda cita que as mudanças na
tensão dos tendões causada pela aplicação de carregamento é negligenciável e a área de aço em
relação a área de concreto também é negligenciável.

2.6 Métodos dos elementos finitos (MEF)

Segundo Gora et al. (2018), o MEF é um método numérico, alguns autores chamam
de método computacional, usado para obter uma solução aproximada de equações diferencias
parciais ou ordinárias através de discretização. E de acordo com Oñate (2009), quando utilizado
para análise de estruturas, o MEF é um método poderoso para computar os deslocamentos,
tensões e esforços na estrutura que está sujeita a um conjunto de cargas.

Altabey, Noori e Wang (2018) dizem que devido a complexidade dos problemas físicos
algumas aproximações devem ser feitas no processo de tornar um modelo real em um matemático,
ele considera as abordagens da figura 2 como um processo de modelagem geral da solução para
um problema, de modo que para alguns problemas reais a solução MEF é a única viável. Sendo
assim, e segundo os mesmos, pode-se dizer que a diferença básica entre os métodos numéricos e
analíticos é que no analítico busca-se uma expressão matemática representando uma solução
geral e exata de um problema representado por equações matemáticas, todavia poucos problemas
tem uma solução exata e as que têm são simplificações da realidade. Por outro lado os métodos
numéricos buscam dar um solução aproximada na forma de um conjunto de números para as
equações que governam um problema. A estratégia, nos métodos numéricos, é transformar as
expressões matemáticas em um conjunto de equações algébricas que dependem de um conjunto
finito de parâmetros, nos problemas práticos essas equações abrangem milhares de variáveis, de
forma que suas soluções só podem ser encontradas com a ajuda de computadores.
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Figura 2 – Diagrama de solução geral.

Fonte: Altabey, Noori e Wang (2018)

Para Vaz (2011), o MEF é uma evolução da formulação do métodos dos deslocamentos
tendo suas raízes nos métodos de energia e nos métodos aproximados. Madenci e Guven
(2015) dizem que o MEF depende da decomposição de um domínio em um número finito
de subdomínios, considerados elementos, para o qual a solução aproximada é construída por
aplicação de métodos residuais ou de pesos. Oñate (2009) tem pensamento semelhante, para ele
o elemento finito pode ser visualizado como uma pequena parte de uma estrutura, a geometria da
estrutura é considerada formada pela agrupamento desses elementos finitos que têm geometrias
simples. Essas geometrias geralmente são triangulares ou quadriláteros em duas dimensões
(2D) e tetraedros ou hexaedros em três dimensões (3D), quando discretiza-se tal estrutura,
transformando ela em um conjunto de diversos elementos finitos, dar-se o nome de malha ou
mesh em inglês (MADENCI; GUVEN, 2015).

2.6.1 O programa ANSYS

O ANSYS Workbench é uma suíte de aplicativos destinado a simulação de vários tipos
de cenários, incluso nele está o programa ANSYS structural analysis, que permite solucionar
problemas estruturais complexos, além de tomada de decisão mais rápida e melhor. Ele trabalha
com a análise de elementos finitos, com essa ferramenta pode-se customizar e automatizar
soluções para os problemas estruturais, parametrizando-os para analisar múltiplos cenários.
Segundo ANSYS (2018), ele é utilizado na industria para permitir que engenheiros otimizem os
seus projetos reduzindo custos de teste físicos para as análises estruturais.

Uma completa gama de ferramentas está disponível no produto para analisar casos de
carregamento simples, vibração, analise linear e não linear de materiais, juntas e geometria
(ANSYS, 2018).
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2.6.2 Tipos de elementos

Ao resolver uma estrutura utilizando o MEF, o domínio é discretizado utilizando ele-
mentos, as características dessa estrutura determinam as dimensões do problema: uma, duas ou
três dimensões. E essas dimensões juntamente aos materiais a serem utilizados determinam os
tipos de elementos a serem empregados, três elementos são apresentados na figura 3, de uma
dimensão com dois nós, duas com quatro nós e três com oito nós (MADENCI; GUVEN, 2015).

Figura 3 – Elementos comuns.

Fonte: ANSYS (2011)

Na literatura foram encontrados dois tipos comumente utilizados na simulação de estru-
turas de concreto, o LINK180 e SOLID65. O LINK180 segundo a documentação é um elemento
3-D que pode ser usado para modelar treliças, cabos flexíveis, links, molas, etc. Possui dois nós
com três graus de liberdade em cada nó: translações nas direções nodais x, y e z. Suportando
apenas tensões de tração ou compressão (figura 4). Já o SOLID65 de acordo com a documentação
é usado para modelagem 3-D de sólidos com ou sem reforço, ele é capaz de fissurar quando
submetido a tensão e esmagar na compressão, tem oito nós com três graus de liberdade em
cada(figura 5). Todavia esses elementos não estão disponíveis diretamente nas novas versões do
ANSYS, são elementos legados e acessíveis somente através de comandos. Ao utilizar o Ansys
Workbench ele automaticamente utiliza o elemento SOLID185, que é usado para modelagem
3-D de estruturas sólidas, sendo definido por oito nós com três graus de liberdade em cada nó.
Ele tem plasticidade, hiperelasticidade, rigidez sob tensão, fluência, grande deflexão e grande
capacidade de deformação, veja a figura 6 (ANSYS, 2011).

Caso semelhante ao do SOLID65 é o LINK180, que também é considerado legado e foi
substituído pelo REINF264 com as propriedades semelhantes, mas com a possibilidade de ser
selecionado diretamente pela interface gráfica do programa (ANSYS, 2011).
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Figura 4 – Elemento Link180.

Fonte: ANSYS (2011)

Figura 5 – Elemento SOLID65.

Fonte: ANSYS (2011)

Figura 6 – Elemento SOLID185.

Fonte: ANSYS (2011)

2.6.3 Modelagem da armadura

Nas simulações encontradas na literatura, foram constatados três tipos de abordagens
para armadura de reforço no concreto, o discreto, o embutido e o distribuído/espalhado. O
discreto, figura 7-a, utiliza elementos de barra conectado a nós da malha de concreto, dessa
forma o concreto e o reforço compartilham nós, sendo que o concreto ocupa as mesmas regiões
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ocupadas pela armadura. Esse é o tipo de modelagem utilizado nos trabalhos que usam o elemento
LINK180, há dois pontos negativos em relação ao uso desse método, primeiro é que o volume da
armadura não é contabilizado e o segundo é que a malha de elementos do concreto é limitada
pela localização da malha da armadura. No modelo embutido, figura 7-b, o reforço é separado
do concreto, não existindo compartilhamento de nós entre o concreto e o aço, de forma que a
rigidez de cada material é avaliada individualmente devido à compatibilidade de deslocamento
dos elementos nos diferentes nós. É uma modelo considerado efetivo, todavia há um considerável
aumento no número de nós e graus de liberdade, aumentando o tempo de execução e do custo
computacional. Já no modelo espalhado, figura 7-c, assume-se que a armadura foi distribuída
uniformemente pelos elementos de concreto em uma região definida da malha, esse tipo de
abordagem é usado para modelos de grande escala e em que o reforço não contribui de maneira
significativa para a estrutura (TAVÁREZ, 2001 apud EFFENDI, 2020).

Figura 7 – Modelos de reforço para aço

Fonte: Effendi (2020)

2.6.4 Modelagem estrutural e análise MEF

Os métodos computacionais, como o MEF, são aplicados a um modelo conceitual de um
problema real, e esse modelo pode ser desenvolvido somente após o entendimento da natureza
física do problema, o modelo conceitual deve ter todos os dados necessários para a representação
e análise da estrutura. O próximo passo depois do modelo conceitual é o modelo estrutural ou
modelo matemático, e ele deve incluir três aspectos fundamentais, a descrição geométrica da
estrutura (linhas, superfícies, volumes, etc.), uma expressão matemática das leis físicas básicas
que descrevem o comportamento da estrutura (condições de contorno, equações de equilíbrio das
forças) e as especificações das propriedades dos materiais e das cargas que atuam na estrutura.
Na sequência tem-se a aplicação do MEF que, envolve a aplicação de código de computador com
as propriedades mecânicas dos materiais, as condições de contorno e as cargas aplicadas, além
das características da discretização como tipo do elemento e tamanho da malha. O resultado
desse processo é o modelo computacional da estrutura. Os passos que podem ser vistos na figura
8 (OÑATE, 2009).

O ANSYS fornece uma interface para definir os parâmetros que serão utilizados na
simulação e realizar os refinamentos caso necessário, não necessitando, na maioria das vezes,
que se conheça os códigos para os parâmetros. É importante salientar que alguns parâmetros têm
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Figura 8 – Passos para um modelo computacional.

Fonte: Oñate (2009).

a capacidade de dar resultados mais precisos, como o tamanho da malha, todavia há um custo
computacional maior.
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3 METODOLOGIA

Neste capítulo descreve-se o procedimento e os parâmetros que utilizados nas simulações.
Buscou-se seguir o modelo proposto por Oñate (2009), ver a figura 8.

Foi utilizado o ANSYS Workbench 2020 R2 versão estudantil, dentro dele, utilizou-se
o módulo Static Structural para realizar as simulações, como pode ser visto na figura 9, esse
módulo tem sete células. A primeira é o submódulo Engineering Data que é responsável por
parte dos parâmetros dos materiais, o segundo é o Geometry nele pode-se desenhar ou importar
a geometria do elemento a ser utilizado, o terceiro é o Model nele faz-se uma ligação entre a
geometria e os materiais e são fornecidos os parâmetros referente a malha, além de definir como
será a interface de ligação entre os elementos, o quarto é o Setup onde se define as condições
de contorno do problema, as forças aplicadas e os apoios, no sexto tem-se o Solution onde se
executa o modelo com os parâmetros anteriores e por último tem-se o Results onde pode-se
conferir os resultados tanto de forma gráfica quanto númerica.

Figura 9 – Módulo Static Structural.

Fonte: O autor.

Como no trabalho há várias alterações em certos elementos optou-se por dividir o
fluxo de trabalho conforme figura 10, neste tipo de fluxo parte das células do Static Structural

são importadas de submódulos separados tornado o fluxo de trabalho facilitado para realizar
alterações. Os módulos tem a mesma função explicada anteriormente, a diferença é que eles
estão em colunas separadas podendo ser importados facilmente em outros módulos, além de dar
uma melhor visualização do fluxo de trabalho.

3.1 Estrutura real

O escopo de estudo do trabalho é a viga central do tabuleiro do vão central da ponte
rodoviária sobre o Rio Sousa, na região metropolitana da cidade de Porto em Portugal, as
informações foram obtidas pelo trabalho de Sousa (2004). O tabuleiro central tem um vão
contínuo de 25 m, construído com vigas pré-fabricadas de 1,20 m de altura, os cortes, transversal
e longitudinal, podem ser vistos na figura 11.
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Figura 10 – Fluxo de trabalho para o modelo computacional.

Fonte: O autor.

Na transversal, as vigas estão conectadas por uma laje com espessura constante de 0,22
m e por lajes alveolares (carlingas) localizadas nos alinhamentos de apoio, há um revestimento
de concreto betuminoso com 6 cm de espessura e passeios localizados junto das laterais.

Na figura 12, têm-se a representação da geometria da viga, que foi utilizada nas simula-
ções, os valores estão em centímetros.

As armaduras ativas e passivas podem ser vistas na figura 13, para o meio do vão e para o
apoio, o diâmetro das armaduras de protensão é de 15,2 mm ou 0,6 polegadas, para as armaduras
passivas usa-se 10, 12, 16 ou 20 mm de diâmetro. Consegue-se ver a distribuição longitudinal
dessas armaduras na figura 14.

3.2 Modelo estrutural

Para a análise foi considerado uma seção com cinquenta milímetros de largura no meio
do vão onde ocorrerá a diminuição da seção de aço. Utilizou-se o SpaceClaim, que faz parte do
conjunto de aplicativos ANSYS, para a modelagem 3D do elemento.

O modelo estrutural foi baseado na figura 12, 13 e 14, com uma simplificação das
armaduras de protensão devido as limitações de apenas cinquenta formas geométricas no uso da
versão estudantil do ANSYS, por isso resolveu-se fazer um barra com área equivalente de dez
barras da figura 13, cada barra segundo Sousa (2004), tem 1,5 cm2 de área, totalizando 15 cm2

para as dez barras, com isso chega-se a uma barra de diâmetro de 43,70 mm com a mesma área
das dez barras. Como são vinte barras na parte inferior, ter-se então duas barras com 43,70 mm
de diâmetro, o modelo pode ser visto na figura 15 e o detalhe no meio do vão pode ser visto na
figura 16.

As armaduras de pele da viga não são consideradas por não terem função estrutural, ape-
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Figura 11 – Corte Transversal e Longitudinal do tabuleiro.

Fonte: Retirado de Sousa (2004).

nas a função de controlar a fissuração e retração do concreto, como também não são consideradas
as armaduras construtivas, por limitação da versão estudantil utilizada.

3.3 MEF

Como mencionado anteriormente não há necessidade de conhecimento da linguagem de
programação do ANSYS, todavia para a imposição dos efeitos de protensão e para a seleção de
outros elementos é necessário o conhecimento de alguns códigos, não foi realizada a mudança
de elemento, e o código da protensão está no no quadro 5 no apêndice. O programa por padrão
utiliza o elemento SOLID185 para todas as geometrias, bastando apenas a seleção dos materiais
a serem utilizados. De forma que apenas os parâmetros físicos dos elementos são necessários.
Para os parâmetros de discretização, foram utilizados os padrões do programa. Foi feito um
reajuste no tamanho da malha de forma a obter um resultado mais preciso, todavia a versão
utilizada limita a quantidade de elementos e nós em 32 mil.

Quando se faz o dimensionamento de estruturas de concreto se considera a aderência
entre as barras e o concreto, no caso em estudo considera-se que a aderência entre esses materiais
é perfeita, não ocorrendo perda de rigidez devido o escorregamento relativo entre os materiais.
Todavia esse não é o caso nas estruturas reais que tenham suas armaduras em um processo de
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Figura 12 – Modelo de viga I.

Fonte: Retirado de Sousa (2004).

Figura 13 – Armaduras no meio e no apoio (à direita).

Fonte: Retirado de Sousa (2004).

corrosão, devido o resultado da corrosão que tem volume maior do que a armadura original
ocorre tensões na região que acabam por retirar a aderência no local, porém essa modelagem é
extremamente complexa e não foi realizada.



40

Figura 14 – Distribuição longitudinal das armaduras passivas e ativa.

Fonte: Retirado de Sousa (2004).

Figura 15 – Modelo estrutural.

Fonte: O autor.

3.4 Parâmetros físicos

O concreto tem um comportamento não linear e para simulá-lo é necessário um elemento
que represente suas propriedades. Os trabalhos de Gora et al. (2018) e de Musmar, Rjoub e
Hadi (2014) utilizaram os elementos SOLID65 e LINK180 para a modelagem do concreto e o
aço, respectivamente. Todavia como mencionado anteriormente o Ansys utiliza por padrão o
elemento SOLID185 e este foi utilizado no lugar do SOLID65.
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Figura 16 – Detalhe para alteração do diâmetro.

Fonte: O autor.

3.4.1 Concreto

Assim como o SOLID65, o SOLID185 modela o comportamento não linear do concreto,
sendo capaz de apresentar deformação plástica, hiper-elasticidade, enrijecimento por tensão,
fluência, grande deflexão e grande deformação, porém ele não apresenta a fissuração em três
direções ortogonais e esmagamento.

As propriedades necessárias para o elemento incluem: módulo elástico (Ec), coeficiente
de Poisson (v) e relação tensão-deformação (ANSYS, 2011). Para o trabalho são utilizadas as
propriedades da tabela 3 e a relação tensão deformação da ABNT (2014) item 8.2.10.1.

Tabela 3 – Parâmetros para o elemento.

Elemento Viga Laje
Classe de resistência C45 C30
fcm (MPa) 53 38
Eci (MPa) 37486 33551
fctm (MPa) 3,82 2,91

Fonte: Retirado de Sousa (2004).

3.4.2 Aço

Na modelagem da armadura são utilizados o modelo embutido e o discreto, para o
embutido foi utilizado o elemento SOLID185 e no discreto o REINF264 que pode ser selecionado
diretamente no ANSYS, assim como o LINK180, ele também é capaz de deformação plástica e
fluência. Na modelagem do reforço são utilizados os parâmetros da tabela 4.
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Tabela 4 – Parâmetros para o aço utilizados.

Coeficiente
Tipo

Aço passivo Aço Protensão
Limite de escoamento (MPa) 500 1860
Módulo de elasticidade (GPa) 200 200

Fonte: Retirado de Sousa (2004).

3.4.3 Forças aplicadas

Sousa (2004) utilizou três tipos de ações que atuam sobre a viga:

• Peso próprio da estrutura – Nesta parte estão o peso das vigas e das lajes onde o seu
volume foi multiplicado por 25 kN

m3 ;

• Cargas permanentes não estruturais – Nesse conjunto estão incluídos o revestimento
betuminoso, a carga do passeio, do guarda corpo, etc.;

• Sobrecarga rodoviária – Constituída de veículos para pontes segundo a norma portuguesa.

Além dessas, ainda tem-se a tensão de inicial de pré-esforço. No trabalho serão utilizadas,
parcialmente, as forças calculadas por ele, essas forças podem ser conferidas na tabela 5.

Tabela 5 – Ações utilizadas.

Ação Valor
Tensão inicial de pré-esforço 1395 MPa

Peso próprio da viga 10,59 kN/m

Peso próprio da laje 11,69 kN/m

Carga permanente 7,87 kN/m

Sobrecarga devido ao veiculo tipo Três forças concentradas de 100 kN,
aplicadas no tramo da esquerda, a
uma distância de 10,8 m, 12,3 m e
13,8 m do apoio à esquerda

Fonte: Sousa (2004).

Devido a necessidade de diminuir o número de elementos e nós, limitação imposta na
versão estudantil, as gargas móveis, sobrecarga devido ao veiculo tipo, foram alteradas para as
da figura 17.

3.5 Valores de deterioração

No trabalho adotou-se os valores da tabela 6 para a taxa de corrosão, porque no trabalho
de Sousa (2004) não está explícito as condições ambientais do local para a seleção de um valor
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Figura 17 – Carga móvel

Fonte: O autor.

Tabela 6 – Taxas de corrosão para estruturas expostas a cloretos.

Descrição/Cimento Comum 30% de cinzas volantes 70% de escória de alto forno

Relação água/cimento 0,66 0,54 0,48

fck aos 28 dias

(MPa)
39 50 38

Taxa de Corrosão (µm/ano) 11 0,6 1,2

Fonte: Bertolini et al. (2013).

mais próximo a realidade.

Bertolini et al. (2013) afirmam que taxas de corrosão menores do que 2 µm/ano são
desprezíveis, que taxas entre 5 e 10 µm/ano são moderadas, que valores entre 10 e 50 µm/ano
são intermediários, que entre 50 e 100 µm/ano são taxas altas e que taxas acima disso são muito
altas. Como dois valores da tabela 6 são desprezíveis utilizar-se-á no trabalho apenas taxa de
corrosão de 11 µm/ano.

Definiu-se o tempo de simulação como 100 anos em intervalos de 5 anos e utilizou-se
as equações 2.1, 2.9, 2.10 e 2.11 para a taxa mencionada anteriormente, resultando na tabela
7. O processo foi colocar a taxa de corrosão na equação 2.9 e obter a densidade corrosão, esse
resultado foi inserido na equação 2.11, obtendo a porcentagem de corrosão, sendo esse valor
inserido juntamento com o diâmetro da barra na equação 2.10 para obter o diâmetro corroído, e
com a tensão de escoamento foi inserido na equação 2.1 para obter o novo limite de escoamento.

3.6 Obtenção dos resultados

A tendência do comportamento da estrutura é ser linear durante do período de iniciali-
zação não ocorrendo grandes mudanças do comportamento, dessa forma não foi feito gráficos
dessa parte, assumindo-se que não há eventos excepcionais nessa fase. Alguns trabalhos como o
de Andrade (2001) e de Félix et al. (2018), conseguem estimar esse tempo baseado em fatores



44

Tabela 7 – Cálculos para taxa de corrosão de 11 µm/ano.

Tempo (anos) Qcorr(%) ds (mm) Limite escoamento (MPa)
1 0.0999 43.68 1860
5 0.500 43.59 1860

10 0.999 43.48 1860
15 1.50 43.37 1860
20 2.00 43.26 1860
25 2.50 43.15 1860
30 3.00 43.04 1860
35 3.50 42.93 1860
40 4.00 42.82 1860
45 4.50 42.71 1860
50 5.00 42.59 1860
55 5.50 42.48 1859
60 6.00 42.37 1859
65 6.50 42.26 1859
70 6.99 42.14 1859
75 7.49 42.03 1859
80 7.99 41.92 1859
85 8.49 41.80 1859
90 8.99 41.69 1859
95 9.49 41.57 1859

100 9.99 41.46 1859

Fonte: O autor.

do ambiente, de projeto e execução da estrutura, todavia esse período não é o foco do trabalho.

Por isso foram construídos apenas os gráficos do período de propagação, já que no
trabalho propõe-se a simular um efeito dessa parte e é, onde de fato ocorre as mudanças da
estrutura devido aos efeitos simulados, dessa forma buscou-se compilar os dados obtidos para a
elaboração dos gráficos de tempo por deformação e tempo por deslocamento. Os gráficos foram
feitos baseados nos resultados da simulação para cada ano da tabela 7.

Foram realizadas simulações utilizando o método embutido e discreto, ver seção 2.6.3,
totalizando 84 simulações, os resultados podem ser conferidos a seguir.
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4 RESULTADOS

Neste capítulo são apresentados os resultados das simulações realizadas, na primeira
seção têm-se os resultados esperados que foram calculados de acordo com a teoria elástica. Na
segunda seção são apresentados as imagens geradas pelo programa para a primeira simulação,
onde nenhum alteração foi realizada nas armaduras, nas seções seguintes os resultados são
compilados em gráficos, para que possam ser analisados.

4.1 Resultados Calculados

Foi utilizado as equações da seção 2.5 para os cálculos, os resultados podem ser conferi-
dos a seguir:

Área:

A = 100 · 14 + 43 · 9,5 + 91 · 14 + 24,5 · 8,5 + 63 · 15

= 4235,75 cm2

Força de protensão:

P1 =
1395 · 1499,867

1000
= 2092,3145 kN

P = 2 · P1 = 4184,6290

Altura centro de gravidade:

ȳ =
(100 · 14) · 113 + (43 · 9,5) · 102,833

A
+

+
(91 · 14) · 60,5 + (24,5 · 8,5) · 17,833 + (63 · 15) · 7,5

A

ȳ = 68,013 cm

Momento de inércia:

Ixx = 8307993,325 cm4

Módulo resistente superior:

Zt =
Ixx

120− ȳ
= 159808,796 cm3

Módulo resistente inferior:

Zb =
Ixx
ȳ

= 122153,171 cm3
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Excentricidade no meio do vão:

e = ȳ − 6,685 = 68,013− 6,685 = 61,328 cm

Cargas permanentes:

Qg = 10,59 + 11,69 + 7,87 = 30,15
kN

m

Mg =
ql2

8
=

30,15 · 252

8
= 2355,46875 kN.m = 235546,875 kN.cm

Considerando as gargas móveis da figura 17, o cálculo do momento fica:

Mq = 400x− 200(x− 10,8)

Para x=12,5 temos:

Mq = 4660 kN.m = 466.000 kN.cm

Tensão no topo:

σt =
P

A
− Pe

Zt
+
Mg

Zt
+
Mq

Zt

σt = 0,988− 1,606 + 1,474 + 2,916 = 3,772
kN

cm2

σt = 37,72 MPa

Tensão na base:

σb =
P

A
+
Pe

Zb
− Mg

Zb
− Mq

Zb

σb = 0,988 + 2,101− 1,928− 3,815 = −2,654
kN

cm2

σb = −26,54 MPa

O deslocamento negativo devido a protensão é:

δp =
P · e · l2

8EI

Considerando que E = 3748,6 kN
cm2 e l = 2500 cm

δp =
4184,629 · 61,328 · 25002

8 · 3748,6 · 8307993,325

δp = 6,438 cm = 64,38 mm
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Deslocamento devido a carga distribuída:

δdmax =
5 · w · l4

384EI

Lembrando que w = 0,3015 kN
cm

δdmax =
5 · 0,3015 · 25004

384 · 3748,6 · 8307993,325

δdmax = 4,924 cm = 49,24 mm

Já devido as cargas pontuais temos as expressões:

Para a carga de 400 kN no centro

δd1max =
F · l3

48EI

δd1max =
400 · 25003

48 · 3748,6 · 8307993,325

δd1max = 4,181 cm = 41,81 mm

Para as cargas de 200 kN a 1080 cm do apoio

δd2max =
F · b(l2 − b2) 3

2

(9
√

3) · l · EI

δd2max =
200 · 1080(25002 − 10802)

3
2

(9
√

3) · 2500 · 3748,6 · 8307993,325

δd2max = 2,040 cm = 20,40 mm

δd3max = δd2max

O deslocamento total é:

δ = δd1max+ δd2max+ δd3max+ δdmax− δp
δ = 6,747 cm = 67,47 mm

4.2 Primeira Simulação

A tensão principal máxima para a viga pode ser vista na figura 18, na figura 19 tem-se a
vista frontal, esses valores estão abaixo da resistência do concreto.

O deslocamento total ficou em 104,57 mm e pode ser conferido na figura 20.

A tensão normal ao eixo z pode ser visualizada na figura 21, notando-se que próximo
aos apoios há picos de tensão e que estas tensões são elevadas se comparadas com o restante da
longarina.

As tensões equivalentes da barra íntegra podem ser analisadas na figura 22.
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Figura 18 – Tensão principal máxima

Fonte: O autor.

Figura 19 – Tensão principal máxima frontal

Fonte: O autor.

4.3 Simulações da Longarina

Foram realizadas 4 grupos de simulações levando em conta o tipo de modelagem da
armadura, cada um com 21 simulações, 2 grupos com o método embutido, sendo o primeiro
com 27 mil elementos/nós, identificado como Emb. 27k nos gráficos, e o segundo com 280 mil,
identificado como Emb. 280k, que foi utilizado como referência. No terceiro, chamado de Disc.

31k, e quarto foi utilizando o método discreto com 31 mil elementos/nós, a diferença entre estes
foi que o terceiro utilizou apenas duas barras com a área total de 10 barras cada e no quarto
foram utilizadas 20 barras, já que no modelo discreto a malha é compartilhada e o número de
elementos/nós não se altera. Todavia os resultados do terceiro e quarto não tiveram diferenças
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Figura 20 – Deslocamento Total

Fonte: O autor.

Figura 21 – Tensão Normal Eixo Z

Fonte: O autor.

significativas, sendo assim optou-se por utilizar apenas três grupos de resultados.

O deslocamento (flecha) máximo pode ser visto na figura 23, o ponto desse deslocamento
é no centro da viga. Os valores permaneceram praticamente constantes para o grupo Emb. 27k e
Emb. 280k, com variação menor do que um milímetro, e o Disc. 31k teve um leve aumento cerca
de um milímetro. As tensões equivalentes, na barra, ficaram inalteradas com o tempo para todas
as simulações, os valores estão na figura 24.

As tensões normais na viga podem ser verificadas nas figuras 25 e 26, sendo que
as tensões negativas significam compressão e as positivas tração, os valores mantiveram-se
invariáveis com o tempo para a tensão mínima e com pouca variação para a máxima.
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Figura 22 – Tensão equivalente barra íntegra

Fonte: O autor.

Figura 23 – Deslocamento Máximo

Fonte: O autor.

Figura 24 – Tensão Equivalente Máxima

Fonte: O autor.

As tensões principais máximas podem ser vistas nas figuras 27 e 28.

4.4 Análise dos resultados

Após a simulação verificou-se que os resultados estavam acima do calculado, o que
era esperado já que segundo Muthu et al. (2016), as equações utilizadas consideram apenas
o regime elástico do material. Outro ponto que foi detectado é que a malha de elementos é
bem pequena para esta simulação, cerca de 16 mil elementos e 11 mil nós, fazendo um total de
27 mil elementos combinados com nós, sendo que a limitação do programa é de 32 mil. Essa
diferença pode ser vista comparando os valores do grupo de referência (280 mil elementos/nós)
com as realizadas na versão estudantil, o número de 160 mil elementos e 120 mil nós foi
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Figura 25 – Tensões normais máximas

Fonte: O autor.

Figura 26 – Tensões normais mínimas

Fonte: O autor.

Figura 27 – Valor máximo

Fonte: O autor.

Figura 28 – Valor mínimo

Fonte: O autor.

escolhido porque ao aumentar o número de elementos da malha além disso não houve alteração
nos resultados da simulação Emb. 280k, o que indica que houve convergência do resultado
em relação àquela malha. Para isso foi utilizado o método de Madenci e Guven (2015), que
recomendam que a simulação seja realizada com um número inicial de elementos e refeita com
um número maior de elementos, caso ocorra mudança significativa nos valores, deve-se adotar
esse novo número de elementos, repetindo o processo até que se obtenha uma convergência dos
resultados para a menor quantidade de elementos, que leve a um resultado aceitável, já que um
número excessivo de elementos pode gerar erros de arredondamento. Todavia não foi possível
realizar esse procedimento na versão estudantil devido a limitação desde.

Observando a figura 24 percebe-se que a tensão de escoamento da armadura não foi
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alcançado, porém na figura 27 a tensão máxima principal alcançou um valor maior do que a
resistência do concreto no grupo Emb. 280k e menor ou igual nos outros dois grupos, isso pode
indicar que houve esmagamento do concreto antes da tensão de escoamento da armadura ser
alcançada. Por outro lado na figura 28 o valor mínimo ficou muito baixo no grupo de simulação
Disc. 31k , o que pode indicar que também houve falha em outro plano do concreto neste grupo.
Estas possíveis falhas provavelmente ocorreram devido ao sobrecarregamento excessivo que foi
feito.

Quanto ao comportamento estrutural, observou-se que não houve aumento considerável
do deslocamento com o tempo, ou mesmo de qualquer outro parâmetro de forma que pudesse
evidenciar deformações mínimas e máximas. O que salienta o comportamento de uma estrutura
de concreto protendido, e mostra que as simulações estão de fato demostrando como seria o com-
portamento da estrutura, considerando o rompimento não fragilizado da armadura. Observou-se
também alguns pontos próximos ao apoio onde a tensão normal mínima subiu consideravelmente,
assim pode-se dizer que os resultados obtidos na figura 26 não representa o resultado esperado,
mas o resultado devido a falta de armadura para absorver o cisalhamento da região, essa armadura
não foi adicionada pela limitação no número de sólidos imposta pelo programa.

Observou-se também que a maioria dos resultados do grupo de simulação discreta
estavam entre as outras soluções, indicando que talvez esse método seja mais eficiente em uma
simulação onde não se tenha o poder computacional elevado ou a disponibilidade de uma malha
mais refinada. Na figura 29 pode-se ver uma comparação em porcentagem dos valores médios
alcançados pela Emb. 27k e Disc. 31k em relação a simulação de referência, na tensão equivalente
máxima os valores da Disc. 31k ficaram apenas 3% fora da média de referência. No geral os
valores da Emb. 27k chegaram a 56,2% do valor de referência e a Disc. 31k chegou em média a
73,5% dos valores.

Figura 29 – Comparação com a simulação referência

Fonte: O autor.
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5 CONSIDERAÇÕES FINAIS

Pode-se verificar que o programa de simulação geral Ansys é muito robusto, todavia a
sua versão estudantil é bastante limitada, assim é preciso que ao utilizar esta ferramenta seja
indispensável modelar estruturas simples, de geometria linear. Pois ao utilizar formas mais
complexas a tendência é que seja necessário um número maior de elementos para a modelagem,
o que não é possível com a versão, introduzindo erros por falta de elementos para alcançar a
precisão adequada. De acordo com Dias et al. (2018), há dois tipos de erros nas simulações, os
erros de concepção e os erros devido a malha insuficiente, pode-se afirmar que neste trabalho foi
verificado apenas o erro devido a malha, já que ao comparar os resultados com um resultado de
referência houve diferença, contudo isto era esperado.

Quanto a hipótese inicial, que é utilizar o programa de elementos finitos para a mode-
lagem de patologia em uma estrutura de concreto protendido, confirmou-se que é possível tal
modelagem, todavia na versão estudantil quando modelado corretamente deve-se esperar que
os resultados apresentados tenham erros de precisão significativos, já que simplificações do
problema real terão que ser feitas. Por outro lado, na solução completa deve-se tomar cuidado
para utilizar o menor número possível de elementos pois o custo computacional tende a crescer
muito e se utilizado um número excessivo pode-se gerar erros de precisão também.

Outro ponto a considerar é que escolher um elemento apropriado para a simulação é uma
tarefa bem árdua, sendo muitas vezes necessário conhecimento além de um curso de graduação.
Desta forma o programa procura facilitar a vida do usuário colocando o elemento SOLID185
como padrão para estruturas sólidas, sendo necessário apenas a definição das propriedades
dos materiais, e quando deseja-se modelar comportamentos mais complexos exige-se outros
elementos, que não são acessíveis diretamente pela interface e suas formulações não são simples.
Outra alternativa para este trabalho seria a verificação de danos no concreto, porém com o
elemento utilizado, não foi exequível realizar tal simulação. O programa fornece outros elementos
com formulações um tanto complexas que podem ser utilizados para tal, mas que estão além do
conhecimento do autor.

O comportamento estrutural, em especial o deslocamento vertical, da viga observado
nas simulações com a taxa de corrosão utilizada foi, praticamente, invariável com o tempo, isso
concorda com o divulgado na literatura, onde o colapso de estruturas de concreto protendido não
dá sinais visuais que possam indicar algum tipo de problema, e visto que as tensões observadas
na armadura não chegaram ao limite estabelecido, é plausível supor que o concreto pode sofrer
esmagamento antes que o limite de tensão da armadura seja alcançado levando ao colapso
abrupto, porém, como mencionado anteriormente, não foi possível modelar esse comportamento
com elemento padrão utilizado, este tipo de colapso foi observado no trabalho de Belletti et al.
(2020), onde elas fazem uma simulação semelhante a desde trabalho, mas com elemento capaz
de simular o esmagamento do concreto.

Os resultados encontrados no capitulo anterior foram diferentes daqueles obtidos por
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Sousa (2004), principalmente em relação as tensões normais no trabalho dele, todavia acredita-
se que isso se deve as simplificações no modelo utilizado, como retirada da armadura de
cisalhamento e da aplicação de uma carga diferente da utilizada por ele, que como mencionado
no capitulo anterior podem ter causado o esmagamento do concreto. Quanto aos outros erros
obtidos, quando compara-se aos resultados, pode-se dizer que são grandes. E de acordo com o
que foi explanado nos resultados, foram feitas muitas simplificações geométricas e visto que
este é apenas um trabalho de conclusão de curso e devido as limitações impostas para a versão
estudantil, seria impossível de ser realizado todas as considerações geométricas, de materiais e
dos elementos para simular com exatidão a estrutura real.

Como trabalho futuro recomenda-se fazer a modelagem da longarina com todas as barras
separadas e com toda armadura de cisalhamento, aplicando a redução do diâmetro em uma
barra por vez até todas as barras, de tal modo que verifique-se o comportamento estrutural.
Aconselha-se, ainda, que ao resolver qualquer modelagem utilizando o método dos elementos
finitos, que sejam feitas várias simulações, com progressivo aumento da quantidade de elementos,
até que se chegue a uma convergência dos resultados com a menor quantidade de elementos,
porque ao introduzir elementos além do necessário pode-se adicionar outros erros.

Por fim outra possibilidade de trabalho futuro é realizar a simulação com uma taxa de
corrosão maior, considerando que a estrutura está em um ambiente mais agressivo e que a taxa
utilizada no trabalho chegou apenas a 10% aos 100 anos, de forma que se utilize uma taxa maior
do que esse valor, para assim confirmar se o deslocamento fica invariável.
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APÊNDICE A – COMO REPRODUZIR A SIMULAÇÃO

O trabalho foi realizado utilizando o Ansys Worknbench 2020 R2 Student, dessa forma
é necessário, que ao reproduzir, seja utilizado uma versão compatível. Devido a simetria da
longarina e as limitações impostas pelo programa, como números de elementos e nós, resolveu-se
simular apenas um quarto da estrutura.

A simulação foi dividida em três partes a primeira é a de Unidades e Materiais, nela são
definidas as unidades e os materiais a serem utilizados no projeto, além de ativar a opção de
visualização Beta Options, que é uma forma de ver a estrutura como um todo apesar de apenas
parte dela ser simulada.

A.1 Unidades e Materiais

Passo 1. Abrir o Workbench e selecionar Units→Unit System (Figura 30).

Passo 2. Na janela Unit System selecionar a linha 8 e coluna B, com o sistema métrico
kg, mm , s, °C, mA, N, mV, após isso fechar a janela e voltar ao Workbench (Figura 31).

Figura 30 – Passo 1.

Fonte: O autor.

Figura 31 – Passo 2.

Fonte: O autor.

Passo 3. Selecionar Tools→Options (Figura 32).

Passo 4. Na janela Options selecionar Appearance rolar a tela para baixo até encontrar
a opção Beta Options marcando-a, clicar em OK e retornar ao Workbench (Figura 33).

Passo 5. Na janela Toolbox selecionar e arrastar Static Structural para a janela Project
Schematic, conforme figura 34, para criar um projeto de simulação estrutural.

Passo 6. Na janela Project Schematic dar um clique duplo com o botão esquerdo do
mouse na célula Engineering Data, para abrir uma nova aba para criação dos materiais (Figura
35).

Passo 7. Na aba A2:Engineering Data selecionar Click here to add a new material e
digitar aco, sem caracteres especiais (Figura 36).
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Figura 32 – Passo 3.

Fonte: O autor.

Figura 33 – Passo 4.

Fonte: O autor.

Figura 34 – Passo 5.

Fonte: O autor.

Figura 35 – Passo 6.

Fonte: O autor.

Passo 8. Ainda na aba A2:Engineering Data selecionar “aco” e na janela Toolbox clicar
duas vezes com o botão esquerdo do mouse em Density, depois em Isotropic Plasticity e por
último em Bilinear IsotropicHardening, isso vai adicionar essas propriedades ao material aco

(Figura 37).

Passo 9. Com “aco” selecionado preencher os campos com os valores da figura 38, o
programa faz o cálculo de alguns parâmetros automaticamente, como Bulk Modulus e Shear

Modulus.

Passo 10. Clicar com o botão direito em “aco” e selecionar Duplicate, figura 39, para
criar uma cópia de “aco”.

Passo 11. Com “aco 2”, cópia de “aco” selecionado, marcar a linha 11 coluna E, figura
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Figura 36 – Passo 7.

Fonte: O autor.

Figura 37 – Passo 8.

Fonte: O autor.

40, para habilitar ele como um parâmetro.

Passo 12. Criar um novo material chamado “Concreto” de maneira semelhante ao
Passo 7, com o “Concreto” selecionado, na janela Toolbox clicar duas vezes com o botão
esquerdo do mouse em Density, depois em Isotropic Plasticity e por último em Multilinear

IsotropicHardening, isso vai adicionar essas propriedades ao material Concreto , figura 41.

Passo 13. Com o “Concreto” selecionado preencher os campos com os valores da figura
42 e após clicar em Tabular na linha 10 coluna B.
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Figura 38 – Passo 9.

Fonte: O autor.

Figura 39 – Passo 10.

Fonte: O autor.

Figura 40 – Passo 11.

Fonte: O autor.

Passo 14. Abra um navegador e acesse o sítio https://www.programiz.com/python-
programming/online-compiler/ , é preciso copiar o código 4 e colar na aba Main.py e clicar em
Run, como na figura 43, após esse procedimento copiar os valores gerados em Shell para um
editor de texto como o Bloco de Notas e salvá-los como pontos.csv.

Passo 15. Voltar ao Workbench, aba A2:Engineering Data na janela Table of Pro-
perties Row 10: Multilinear IsotropicHardening clicar na coluna B com o botão direito e
selecionar Import Delimited Data, figura 44.

Passo 16. Na janela Delimited Data Import clicar em Browse e selecionar o arquivo
pontos.csv e clicar em abrir, marcar e modificar os campos conforme figura 45, dando atenção
especial para unidades, clicar em OK.

Passo 17. Fechar a aba A2:Engineering Data e voltar para a aba Project.
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Figura 41 – Passo 12.

Fonte: O autor.

Figura 42 – Passo 13.

Fonte: O autor.

Figura 43 – Passo 14.

Fonte: O autor.

Figura 44 – Passo 15.

Fonte: O autor.

A.2 Geometria

Passo 18. Clicar duas vezes em Geometry para abrir o SpaceClaim, figura 46.

Passo 19. Na janela SpaceClaim ir em File→SpaceClaim Options, figura 47.

Passo 20. Na janela SpaceClaim Options clicar em Units, verificar se unidades estão
em acordo com as da figura 48.

Passo 21. Na janela SpaceClaim selecionar Sketch→Groups, figura 49.

Passo 22. Na janela Groups clica em um espaço vazio com o botão direito e selecionar
Create Script Parameter, figura 50, repetir esse processo até que se tenha quatro parâmetros.
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Figura 45 – Passo 16.

Fonte: O autor.

Figura 46 – Passo 18.

Fonte: O autor.

Figura 47 – Passo 19.

Fonte: O autor.

Passo 23. Ainda na janela Groups, clicar com o botão direito sobre cada um dos
parâmetros e selecionar Unit Type →Unitless, figura 51.

Passo 24. Clicar com o botão direito sobre cada um dos parâmetros e selecionar Re-
name, figura 52. Renomear o Parameter1 para BeamLength, Parameter2 para RebarDiameter,
Parameter3 para RebarRustLength e Parameter4 para RebarRustDiameter. O primeiro é o
comprimento da viga, o segundo é o diâmetro da barra íntegra, o terceiro e o quarto são o
comprimento e o diâmetro da barra corroída.

Passo 25. Clicar em Type para colocar o valores de cada parâmetro em milímetros,
para BeamLength colocar 12500, para RebarDiameter colocar 43,7, para RebarRustLength
colocar 25 e para RebarRustDiameter colocar 43,7. Para modificar a geometria basta trocar o
valor de RebarRustDiameter para os valores da tabela 7.

Passo 26. Na janela SpaceClaim selecionar File→New→Script, figura 53.
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Figura 48 – Passo 20.

Fonte: O autor.

Figura 49 – Passo 21.

Fonte: O autor.

Figura 50 – Passo 22.

Fonte: O autor.

Figura 51 – Passo 23.

Fonte: O autor.

Passo 27. Copiar o código B e colar na janela Script Editor e clicar em Run, triângulo
verde na figura 54, Após isso fechar o SpaceClaim não salvando nada, retornar ao Workbench,
pois o conteúdo pode ser salvo neste.

A.3 Modelagem e Simulação

Passo 28. Clicar duas vezes em Model para abrir o Mechanical, figura 55.

Passo 29. Conferir se as unidades estão compatíveis com as do inicio do projeto, na
janela do Mechanical, figura 56.

Passo 30. No Mechanical ir na janela Outline e clicar com o botão direito em Model

(A4) e selecionar Insert→Symmetry, figura 57.
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Figura 52 – Passo 25.

Fonte: O autor.

Figura 53 – Passo 26.

Fonte: O autor.

Figura 54 – Passo 27.

Fonte: O autor.

Passo 31. Ainda na janela Outline, clicar com o botão direito em Symmetry e selecionar
Insert→Symmetry Region, figura 58, repetir esse processo, de forma que se tenha duas regiões.

Passo 32. Selecionar Symmetry Region e na janela Details of “Symmetry Region”
mudar os elementos de forma que fiquem iguais ao da figura 59.

Passo 33. Selecionar Symmetry Region 2 e na janela Details of “Symmetry Region 2”
mudar os elementos de forma que fiquem iguais ao da figura 59. Os valores são diferentes do
passo anterior.

Passo 34. Expandir Geometry e selecionar SYS \I Beam na janela Details of “SYS \I
Beam” mudar Assignment para Concreto, figura 61. Esse é o material “Concreto” criado no
inicio.

Passo 35. Em Geometry selecionar SYS \Rebar 1 na janela Details of “SYS \Rebar 1”
mudar Assignment para aco, figura 62. Esse é o material “aco” criado no inicio.
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Figura 55 – Passo 28.

Fonte: O autor.

Figura 56 – Passo 29.

Fonte: O autor.

Figura 57 – Passo 30.

Fonte: O autor.

Figura 58 – Passo 31.

Fonte: O autor.

Passo 36. Selecionar SYS \Rebar 2 na janela Details of “SYS \Rebar 2” mudar Assign-

ment para aco 2, figura 63. Esse é o material “aco 2” criado no inicio.

Passo 37. Selecionar Symmetry e na janela Details of “Symmetry” mudar os valores de
acordo com a figura 64. Isso habilita a visualização a estrutura como um todo.

Passo 38. Selecionar Mesh e na janela Details of “Mesh” mudar os Element Order parar
Linear, figura 65. Isso possibilita a diminuição do número de elementos e nós na simulação de
forma que se tenha um número menor do 32.000 elementos, limitação da versão estudantil, se
for utilizado uma versão com linceça do Ansys, aconselha-se, não mexer neste parâmetro.

Passo 38. Botão direito em Mesh e selecionar Generate Mesh, figura 66.

Passo 40. Clicar com botão direito Static Structural e selecionar Insert→Fixed Support,
figura 67. Isso adiciona uma restrição de movimento na estrutura.

Passo 41. Selecionar Fixed Support e em Details of “Fixed Support” mudar os valores
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Figura 59 – Passo 32.

Fonte: O autor.

Figura 60 – Passo 33.

Fonte: O autor.

para os mesmo da figura 68. Este passo determina que há uma restrição de movimento em todos
os eixos da geometria chamada “Support”.

Passo 42. Clicar com botão direito Static Structural e selecionar Insert→Force, figura
69. Repetir esse processo mais duas vezes, de modo que se tenha 3 forças.

Passo 43. Selecionar Force e em Details of “Force” alterar o valod de Magnitude para
-188437,5 N, figura 70.

Passo 44. Selecionar Force 2 e em Details of “Force 2” alterar o valod de Magnitude
para -100000 N, figura 70.

Passo 45. Selecionar Force 3 e em Details of “Force 3” alterar o valod de Magnitude
para -100000 N, figura 70.

Passo 46. Clicar com botão direito Static Structural e selecionar Insert→Commands,
figura 73.

Passo 47. Selecionar Commands (APDL) e na janela Commands colar o código 5, figura
74.
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Figura 61 – Passo 34.

Fonte: O autor.

Figura 62 – Passo 35.

Fonte: O autor.

A.4 Solução e Visualização

Passo 48. Clicar com botão direito Solution e selecionar Solve, figura 75.

Passo 49. Para inserir gráficos basta clicar com o botão direito em Solution e selecionar
Insert escolhendo o tipo desejado, após é so clicar com o direito e selecionar Evaluate All Results,
figura 74.
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Figura 63 – Passo 36.

Fonte: O autor.

Figura 64 – Passo 37.

Fonte: O autor.
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Figura 65 – Passo 38.

Fonte: O autor.

Figura 66 – Passo 39.

Fonte: O autor.
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Figura 67 – Passo 40.

Fonte: O autor.

Figura 68 – Passo 41.

Fonte: O autor.
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Figura 69 – Passo 42.

Fonte: O autor.

Figura 70 – Passo 43.

Fonte: O autor.
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Figura 71 – Passo 44.

Fonte: O autor.

Figura 72 – Passo 45.

Fonte: O autor.

Figura 73 – Passo 46.

Fonte: O autor.
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Figura 74 – Passo 47.

Fonte: O autor.

Figura 75 – Passo 48.

Fonte: O autor.

Figura 76 – Passo 49.

Fonte: O autor.
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ANEXO A – CÓDIGOS

Quadro 4 – Código tensão deformação do concreto

E0=0.002
Eu=0.0035
Fck=53 #MPA
E=0.0001
#The below parameters are for the precision
precision=0.0001 #
format="%.4f" #print four digits after decimal point
#end of precision
#first row
print("0;0,00000000001")

while E < Eu:
if E<=E0:

ten= Fck*(2*(E/E0)-(E/E0)**2)
else:

ten=Fck
print(str(format % E).replace(’.’, ’,’)+";"+str(format % ten).replace(’.’

, ’,’))
E = E + precision

Fonte: O autor.

Quadro 5 – Código para Protensão

! stress
STRAIN_VALUE=1395/200000
esel,s,mat,,2
! plastic strain
inistate,set,dtyp,eppl
inistate,set,csys,0 ! global coordinate system
! Material 2 will have the initial state set
inistate,set,mat,2
! this is how the command works
! inistate,define,,,,,stressX,stressY,stressZ
inistate,define,,,,,,,STRAIN_VALUE ! only the z value is set
allsel,all

Fonte: O autor.
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ANEXO B – CÓDIGO PARA GEOMETRIA

Devido o código da geometria ser extenso e para uma melhor visualização resolveu-se
colocá-lo em um capítulo a parte. O autor é o criador do mesmo e o código pode ser conferido
abaixo.

# Python Script, API Version = V19

#Beam Settings

beamLength=MM(-1*Parameters.BeamLength)

startPointX=MM(0)

startPointY=MM(600)

topWidth=MM(500)

topHeight=MM(140)

topToMidleHeight=MM(95)

topToMidleWidth=MM(430)

midleHeight=MM(730)

middleToBottonleHeight=MM(85)

middleToBottonWidth=MM(245)

bottonHeight=MM(150)

bottonWidth=MM(630/2.0)

#Rebar Settings

circleRadius = MM(Parameters.RebarDiameter/2.0)

offsetFromBottonBase = circleRadius+MM(45)

circleX1 = startPointX+circleRadius+MM(20)

circleY1 = (startPointY-topHeight-topToMidleHeight-midleHeight-bottonHeight

-middleToBottonleHeight)+

offsetFromBottonBase

rebarRustLength = MM(Parameters.RebarRustLength)

rebarRustRadius = MM(Parameters.RebarRustDiameter/2.0)

rebarLength = beamLength + rebarRustLength

#Delete every component

part = GetRootPart()

comp = part.GetComponents()

bodies = part.GetBodies()

curves = part.Curves

for cmp in comp:

cmp.Delete()

for bd in bodies:

bd.Delete()

for crv in curves:

crv.Delete()

#EndBlock

#Select the plane XY

sectionPlane = Plane.PlaneXY
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result = ViewHelper.SetSketchPlane(sectionPlane, None)

# Sketch Top Right Line

firstPoint = Point2D.Create((startPointX), (startPointY))

end = Point2D.Create((startPointX+topWidth), (startPointY))

result1 = SketchLine.Create(firstPoint, end)

# EndBlock

# Sketch Top Side Right Line

start = end

end = Point2D.Create(end.X, (end.Y-topHeight))

result1 = SketchLine.Create(start, end)

# EndBlock

# Sketch Top Right to Middle Line

start = end

end = Point2D.Create(end.X-(topToMidleWidth), end.Y-(topToMidleHeight))

result2 = SketchLine.Create(start, end)

# EndBlock

# Sketch Middle Right Line

start = end

end = Point2D.Create(end.X, end.Y-(midleHeight))

result3 = SketchLine.Create(start, end)

# EndBlock

# Sketch Middle to Bottom Right Line

start = end

end = Point2D.Create((end.X+middleToBottonWidth), (end.Y-

middleToBottonleHeight))

result4 = SketchLine.Create(start, end)

# EndBlock

# Sketch Bottom Right Line

start = end

end = Point2D.Create((end.X), (end.Y-bottonHeight))

result5 = SketchLine.Create(start, end)

# EndBlock

# Sketch Bottom Base Line

start = end

end = Point2D.Create((end.X-bottonWidth), (end.Y))

result6 = SketchLine.Create(start, end)

# EndBlock

# Sketch Middle Line

start = end
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end = firstPoint

result7 = SketchLine.Create(start, end)

# EndBlock

# Sketch First Circle

origin = Point2D.Create(circleX1, circleY1)

result13 = SketchCircle.Create(origin, circleRadius)

# EndBlock

# Fill Last Lines To Create a Body

selection = Selection.Create([GetRootPart().Curves[0],

GetRootPart().Curves[1],

GetRootPart().Curves[2],

GetRootPart().Curves[3],

GetRootPart().Curves[4],

GetRootPart().Curves[5],

GetRootPart().Curves[6],

GetRootPart().Curves[7],

GetRootPart().Curves[8]])

secondarySelection = Selection()

options = FillOptions()

result = Fill.Execute(selection, secondarySelection, options, FillMode.

ThreeD, None)

# EndBlock

part = GetRootPart()

# Get the bodies directly under the root part

bodies = part.GetBodies()

part.Bodies

#Last body created

bd = bodies[bodies.Count-1]

# Select and Extrude Last Body to create a New Body

selection = Selection.Create(bd.Faces[bd.Faces.Count-1])

options = ExtrudeFaceOptions()

options.ExtrudeType = ExtrudeType.Cut

result = ExtrudeFaces.Execute(selection, beamLength, options)

# EndBlock

# Delete bd

selection = Selection.Create(bd)

result = Delete.Execute(selection)

# EndBlock
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#get all boddies again

part = GetRootPart()

bodies = part.GetBodies()

#Last body created

bd = bodies[bodies.Count-1]

#Rename It

bd.Name = "I Beam"

slc=Selection.Create(bd)

slc.CreateAGroup("I Beam")

# EndBlock

#The Rebar

startPt=Point.Create(circleX1,circleY1, MM(0))

endPt=Point.Create(circleX1,circleY1, rebarLength)

radiusPt=Point.Create(circleX1+circleRadius,circleY1, rebarLength)

options = ExtrudeType.ForceIndependent

result = CylinderBody.Create(startPt,endPt,radiusPt,options)

# EndBlock

#Rename The Rebar

bodies = part.GetBodies()

bd1 = bodies[bodies.Count-1]

#Rename It

bd1.Name = "Rebar 1"

#Create a selection Group

slc=Selection.Create(bd1)

slc.CreateAGroup("Rebar")

# EndBlock

type=Plane

if rebarRustLength > 0:

rustStartPt=endPt #last point

rustEndPt = Point.Create(rustStartPt.X,rustStartPt.Y, rustStartPt.Z-

rebarRustLength)

radiusPt = Point.Create(rustEndPt.X+rebarRustRadius,rustEndPt.Y,

rustEndPt.Z)

options = ExtrudeType.ForceIndependent

result = CylinderBody.Create(rustStartPt,rustEndPt,radiusPt,options)

#Rename the rebar

bodies = part.GetBodies()

bd2 = bodies[bodies.Count-1]

bd2.Name = "Rebar 2"

slc=Selection.Create(bd2)

slc.CreateAGroup("Rebar 2")

contFaces=0

for desFace in bd2.Faces:

contFaces+=1

surface = desFace.Shape.Geometry
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if isinstance(surface, type) and bd2.Faces.Count==contFaces:

face2=desFace

else:#else face 2 is on bd1

contFaces=0

for desFace in bd1.Faces:

contFaces+=1

surface = desFace.Shape.Geometry

if isinstance(surface, type) and bd1.Faces.Count==contFaces:

face2=desFace

# EndBlock

#create some named selections

#bd= I beam, bd1=rebar and bd2 is rebar2

# Find faces based on shape type

#bodies = GetRootPart().GetChildren[IDesignBody]()

#faces = List[IDesignFace]()

area=0.0

type=Plane

contFaces=0

for desFace in bd.Faces:

contFaces+=1

surface = desFace.Shape.Geometry

if contFaces==1: #

slc=Selection.Create(desFace)

slc.CreateAGroup("Load")

continue

if (contFaces== bd.Faces.Count-1) and isinstance(surface, type):

face1=desFace

if desFace.Shape.Area>area and isinstance(surface, type):

area=desFace.Shape.Area

face=desFace

slc=Selection.Create(face)

slc.CreateAGroup("X simetry")

#Create selection for Z

slc=Selection.Create(face1,face2)

slc.CreateAGroup("Z simetry")

#Creating the support plate

options = ExtrudeType.ForceIndependent

startPt=Point.Create(MM(0),MM(-600),MM(0))

endPt=Point.Create(MM(315),MM(-700),MM(-200))

result= BlockBody.Create(startPt,endPt,options)
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support=result.CreatedBody

slc=Selection.Create(support.Faces[2])

slc.CreateAGroup("Support")

#Creating the loads plates

#load 1

startPt=Point.Create(MM(0),MM(610),beamLength+MM(200))

endPt=Point.Create(MM(500),MM(600),beamLength)

result= BlockBody.Create(startPt,endPt,options)

support=result.CreatedBody

slc=Selection.Create(support.Faces[0])

slc.CreateAGroup("Load 1")

#load2

startPt=Point.Create(MM(0),MM(610),MM(-10700))

endPt=Point.Create(MM(500),MM(600),MM(-10900))

result= BlockBody.Create(startPt,endPt,options)

support=result.CreatedBody

slc=Selection.Create(support.Faces[0])

slc.CreateAGroup("Load 2")
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